FDOT Civil 3D Tips and Tricks

FDOT State Kit for AutoCAD Civil 3D

besign Jraining

Mike Racca

CADD APPLICATIONS SUPPORT

Florida Department of Transportation S ——
P p Qf’i

ENGINEERING S CADD

Email: Mike.Racca@dot.state.fl.us SYSTEMS OFFICE

Phone: 850-245-1631




FDOT Civil 3D Tips and Tricks

User Interface Tips
Customizing the Quick Access Toolbar
Object Selection Tips

Layer Tips

13

BPesign Training

EXDo



FDOT Civil 3D Tips and Tricks

User Interface Tips — General

Select command options from the command line NEW!
Sticky Panels

Search for commands in Application Menu
QVLAYOUTS to quickly move through layouts

Alt to drive ribbon from keyboard commands
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FDOT Civil 3D Tips and Tricks

User Interface Tips — General
Select command options from the command line NEW!

Instead of typing in the desired command, you can now pick the option you want directly from the
command line.

Command: ARC
Arc creation direction: Counter-clockwise
(hold Ctrl to switch direction).

Specify start point of arc or [Center]:
_endp of

- _."'- ARC Specify second point of arc or .
ER N [Center End]:

Command: OFFSET

Current settings: Erase source=No
Layer=Source OFFSETGAPTYPE=0

- &AL - OFFSET Specify offset distance or [
ER SN T gh Erase Layer] <Through>:

¥ p 906
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FDOT Civil 3D Tips and Tricks

User Interface Tips — General

Sticky Panels

Select the Panels from the AutoCAD ribbon and drag to a desired location. This is helpful when
switching between tabs. Simply drag the panel back to the ribbon to replace.
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FDOT Civil 3D Tips and Tricks

User Interface Tips — General

Search for commands in Application Menu

Select the AutoCAD “A” logo and type in a desired command and AutoCAD will search for
matches. Select the desired match from the generated list.

Ard b 4

qDBE®®v®v|{§§cwnso +|= .DBE@%vwv|{§qu =
arc ¥

ent - ﬁ Intersect
g Assembl
r i Pipe Met

El Matches for: “arc

Matches for: "Arc”
Best Matches

Eest Matches . ‘,A 3-Point
7 3-Paint | ign =
ic (‘ Start, Center, End
- ]
£, Start, Center, End {7 Start, Center, Angle |
/7 Start, Center, Angle & Start.. Siatienter Anol
e Creates an arc using a start peint, center, and an included angle
Z Start,... (/‘ Start, End, Angle = ARC
77 Start, End, Angle ¥ Start,.. Press F1 for more help

ﬂ Start, End, Radius

¥ start,...

7] start, End, Radius

{: Center, Start, End

f: Center, Start, End
fA: Center, Start, Angle

ﬂ Center...

f.j Continue
Application Menu

@ Archive
Ribbon Tab: Home

L?'- Create Best Fit Arc

| Options | | Exit AutoCAD Civil 30 2014
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FDOT Civil 3D Tips and Tricks

User Interface Tips — General

QVLAYOUT to quickly move through layouts

Quickly preview layouts before selecting the desired layout.

IMODELEIQI 5 =

Section Sheet - (15)

» | v WREIF Layout1 { Section Sheet - (15) { DRAINAGE STRUCTURES { Section
139.7504, 597795.6810, 0.0000 45| Bl e [O0] £ L2+
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FDOT Civil 3D Tips and Tricks

User Interface Tips — General

ALT

Press ALT to control AutCAD from the keyboard. Shortcut keys will appear next to Icons letting
you know what keys to type to execute a specific command.
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oolspace i .
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FDOT Civil 3D Tips and Tricks

Customize the Quick Access Toolbar
D@E@%v@-{é}cwilso v|®

Remove Workspace (duplicate)

Add Layer drop-down for speedy access
Add Styles to QA toolbar (not Text Styles!)
Add favorite commands with Quick CUI

Move QA Toolbar below the ribbon
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FDOT Civil 3D Tips and Tricks

Customize the Quick Access Toolbar

Remove Workspace (duplicate)

Workspace is located in two places. One is on the Quick Access tool bar, the other is located on
the bottom right corner. Since you don’t need both, why not turn the one on the Quick Access tool
bar off? To disable Workspace from the QA tool bar, right click and select “Remove from Quick
Access Toolbar”.

EHOR -

- | {53 Civil 3D =
= = — Remove from Quick Access Toolbar

Insert

Add Separator %

Customize Quick Access Toolbar

Q @ Pan EﬂTop
-,ﬁ; Orbit ~ @Bottom

Show Quick Access Toolbar below the Ribbon
q Extents - et 2

Back

-

To turn Workspace back on, select the down arrow the QA toolbar and select Workspace.

|0 & H S K - - |isicvil3p

Customize Quick Access Toolbar

v New

& Pan @Top
. s
4 Orbit - (acttom _ P g v open
Back View « Save
y[)' Extents - ﬂLE& % Manager E

« Plot

Navigate 2D Views

+ Undo
+ Redo

Ls

Active Drawing View -] E‘ Workspace
£+ Drawingl 8 Press F1 for more help
]
‘@’ Points a

Plot Previ
[#] Point Groups ot Preview

- (@ Point Clouds — Properties
(5 Surfaces Sheet Set Manager
"3 Alignments & Render
@ Sites g
5 More Comman ds...

-[B] catchments
Show Menu Bar

ﬁ@ m Pipe Networks
m Pressure Networks Show Below the Ribbon
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FDOT Civil 3D Tips and Tricks

Customize the Quick Access Toolbar

Add Layer drop-down for speedy access

Add commands to the QA toll bar such as the Layer drop-down menu for quick access. Right click
on the desired command and select “Add to Quick Access Toolbar”.

’- &% %544 %0 R X2
Unsaved Layer State Pste FD / @ -
- it el )
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Show Tabs k
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FDOT Civil 3D Tips and Tricks

Customize the Quick Access Toolbar
Add Styles to QA toolbar (not Text Styles!)

Add commands to the QA toll bar such as the Annotate menu for quick access. Right click on the
desired command and select “Add to Quick Access Toolbar”.

|._.I A FDOT - Al FROT z
] Add to Quick Access Toolbar el D = E @ <h M Q gfl:lo
o b sl 3 W w iRl =2 i
Dume'nswn Show Tabs » :> ne s€ Annotate e A FDOT
—
| Dimensions ~ show Eanele 2 \f\ H+ A ABC A FDOT ndard A
e

‘ .1 2, 2 Point Twist LandXML Converter

o Untwist View Land¥ML Grouper
Create kB E

File 9 lenath Cale G52 Swan Parts

Adf}to Quick Access Toolbar
a Show Tabs k
Show Panels »
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FDOT Civil 3D Tips and Tricks

Customize the Quick Access Toolbar

Add favorite commands with Quick CUI (Customize User Interface)

Add commands to the Quick Access using the “More Commands” options. Type in the name of
the desired command and drag it to the Quick Access Toolbar.

Joedcs o [gasDs

H Customize Quick Access Toolbar Epy

NEN.-EE g H [T

v Fa— e ¥ Open
Add  Add | Multiline Check — =X Dimension | oo |
Labels ™ Tables”|  Test  Spelling 00756 - -

v Plot
+ Unde
+ Redo

Labels & Tables ~ Text =

Customizations in All Files

i| To.add a command, drag a command from the Command List pane
Workspiace tl} Quick Access toolbar, a toolbar, of tool palette.

Save As...

Active: Drawing View ] .
2 ¥ Match Rropertles ' Command List: ki
7 B; 8 T Batch Plot — = 5
Points £ - * ‘
[&] point Groups Plot Preview | ‘
@ Point Clouds = Properties | All Commands Dnly '] {\d 28 ;
@ Surfaces Sheet Set Manager It

623 Alignments

- By Sites
Catchments

& 3| Pipe Networks
I Pressure Networks =
Corridors

Render
s

More Commands...

Settings

é Erase PLANNING ALYSIS
"4 Erase
&= cwu.

oA CEraE

Press F1 for more help
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FDOT Civil 3D Tips and Tricks

Customize the Quick Access Toolbar
Move QA Toolbar below the ribbon
More the Quick Access toolbar below the ribbon for faster access to commands and also to prevent

clicking on the wrong commands. Right-click on the QA tool bar and select “Show Quick Access
Toolbar below Ribbon”.

D@.E@(ﬁ,é | T v B | & ennT =

Remaove from Quick Access Toolbar

= Add Separator
-1 Iz, 2 Point Twist LandXM .

Customize Quick Access Toolbar
I Untwist View [fa] LandXM

Create Shor{Quick Access Toolbar below the Ribbon

File 2p LengthCalc @& Swap Pa

2. 2 Point Twist LandXML Converter (%] FDOT Signs
R b = B3 TRNS'port [ L
% & Untwist View LandXML Grouper

o= Place Block Gro
Create Entity ° e B compbook [ ¢
File EI] Length Calc ﬁ Swap Parts LaneSlope | Manager B} Pavement Markings '

) Tools Draw Pay Items Quantitie
GCeBoo do Daal_ Janor 1)

[=1[Top]|2D Wireframe]
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FDOT Civil 3D Tips and Tricks
Object Selection Tips

Add Selected — Objects and Dimensions
Add Selected — Text and Hatch
Selection Cycling (Ctrl+W)

Object Isolation
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FDOT Civil 3D Tips and Tricks
Object Selection Tips

Add Selected — Objects and Dimensions

Creates a new object of the same type and general properties as a selected object, but with
different geometric values. After you select an object, you are prompted to specify geometric values
for the new object, such as a new start point, size, and location. For example, if you select a circle,

the new circle adopts the selected circle's color and layer, but you specify a new center point and
radius.

Repeat ERASE
Recent Input

Isolate Objects
Clipboard

Basic Medify Tools
Display Order

El Properties...
[ Quick Select...

Annotative Object Scalé
* o Add Selacted

Edit Dimension Style...

[E# Object Viewer...

Select Similar

y =
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FDOT Civil 3D Tips and Tricks
Object Selection Tips

Add Selected — Text and Hatch

Creates a new object of the same type and general properties as a selected object, but with
different geometric values. After you select an object, you are prompted to specify geometric values
for the new object, such as a new start point, size, and location. For example, select an existing
hatch pattern inside the drawing, right click and select “Add Selected” then left click inside a closed
internal object.

Repeat QSAVE
Recent Input

Isolate Objects
Clipboard

Basic Modify Tools
Display Order

Properties...
[ Quick Select...

°'5~ ADDSELECTED Specify internal point or [Properties Select objects
dral boundary remove Boundaries Advanced DRaw order Origin ANnotative -

Set Origin hatch COlor LAyer Transparency]:
Set Boundary

Generate Boundary
Hatch Edit...

|« Add Selected

s

@ Object Viewer...

Select Similar
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FDOT Civil 3D Tips and Tricks
Object Selection Tips

Selection Cycling (Ctrl+W)

Selection cycling allows you to select objects that are overlapping. You can control whether a blue
cursor icon displays to indicate overlapping objects and you can configure the display settings of

the Selection list box.

Lommana: <>election Lycl)

¥~ T

ol B e [O]0] £ [+ [+ 0] a0
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FDOT Civil 3D Tips and Tricks
Object Selection Tips

Object Isolation

»
. Isolate Objects J CF Isolate Selected Objects

Clipboard ' Hide Selected Objects
Basic Modify Tools 3 End Isolation
Display Order

: Prnpema;.”
[1 Quick Select...

@ Object Viewer...

Select Similar

End Object Isolation by right clicking on the Red Light Bulb located at the bottom right hand corner
of the screen and selecting “End Object Isolation”.

Isclate Additional Objects

= | ; Hide Objects
=L End Object Isclation
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FDOT Civil 3D Tips and Tricks
Layer Tips

Layer Translator (LAYERTRANS) — Translate layers to a standard (dws, dwg or dwt)
LAYWALK (View layers individually)

LAYDEL (delete even the most stubborn layers!)

COPYTOLAYER
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FDOT Civil 3D Tips and Tricks

Layer Tips
Layer Translator (LAYERTRANS) — Translate layers to a standard (dws, dwg or dwt)
Translates the layers in the current drawing to specified layer standards.
In the Layer Translator, you specify the layers in the current drawing that you want to translate,

and the layers to translate them to. The translation maps the layers in the current drawing to

different layer names and layer properties in a specified drawing or standards file, and then
converts them using those mappings.

-
A Layer Translator E
Translate From Translate To
gu - gﬂ P
£l ActivePointCell_dp | £5 ActivePointCell_dp |
gAsohaRConc gﬂdwcPoim_dD
£ AsphattMiling_px £F ArchSte _ep
£Z BamierWall £ MficialCovering
£ BarmieWal_px £Z AsphaltConc
- E i £Base £Z AsphaltMiling
utput Help  Express Tools Add-Ins FDC ()= £ Base_px £Z AsphattMiling_px
— 4 i \ £Z AsohaltMisc <
H - =1 Import » [ Visual Basic Editor |£R Layer Translator [ T—
EI. EJ/ ;m P l_} ' VB —; Y k Selection Fiter Map | < I ] »
Export Visual LISP Editor Check lact
User  Tool OB EP foul un B YEIEFER I:> .
Interface Palettes [ Edit Aliases = | Application Script [gg Run VBA Macro Configure P
Customization Applications ¥ CAD Standards - -
Old Layer Name New Layer Name Color Linetype  Linewei... Transparency Plot style
PsthMsc AsphaltConc 2551650 Continu... 030mm 0 255
(Transiste ] [ Concel ] [ Heb
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FDOT Civil 3D Tips and Tricks
Layer Tips
LAYWALK (View layers individually)
Displays objects on selected layers and hides objects on all other layers.

Use this command to review the objects on each layer and to purge unreferenced layers.

By default, the effect is temporary and layers are restored when you close the dialog box.

FDOT o
a3 | | Z N S S 2 —
=F | 2| |2 |5, | | |4
£ = & v Ta | 3 ‘) GipBorder_dp
Unsaved Layer State v Concrete
Paste Concrete_px

E%S EoP hd ’ Conduit
Q taf U I:> ContoursMajor_dp
; Clipboa ContoursMajor_ep

ContoursMinor_dp

158 4% & 25 B 2 %) CordoussMincr_ep
1R e 7 CURB FLAT
CurbBack
= Loyers '
10 S | Lg”’bnfmﬂ o -
P [7]Restore on extt [ Help ] [Close
@eﬂgﬂ Training 22
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FDOT Civil 3D Tips and Tricks
Layer Tips
LAYDEL (delete even the most stubborn layers!)

Deletes all objects on a layer and purges the layer.

ROT @
S 2B E5 %% @
Unsaved Layer State v

Paste
Q %o [ 0P ]|
| Clipbo

%%%%%%E%?I
cked layer fading ] 65%

Layers

tmcgtn
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FDOT Civil 3D Tips and Tricks
Layer Tips

COPYTOLAYER

Copies one or more objects to another layer.

Creates duplicates of selected objects on a layer that you specify. You can also specify a different
location for the duplicated objects.

8 2 8% B £ 858 \|%% @
Unsaved Layer State v

¢ taf [ EOP =
; Clipbo

%-ﬁ%%%%%g‘*

65%
£

Paste

&

Layers
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1. Command input settings

In AutoCAD 2014 you can customize the behavior of the command line using controls in the Input Settings
menu when you right-click on the command line. In addition to the previous options to enable AutoComplete
and search for system variables, you can enable AutoCorrect, Search Content, and Mid-string Search. All of
these options are turned on by default.

Recent Commands v

Input Settings » | v AutoComplete

Lines of Prompt History v AutoCorrect

Input Search Options... v Search System Variables
¢ v Search Content
_op v Mid-string Search

Copy History Delay Time

Transparency...

Options...

Another right-click option provides access to the new Input Search Options dialog box.

o
& Input Search Options M
A,u}°c°mp!°te V! Search content at command line
(¥! Enable AutcComplete _—
(V] Enable Mid-string search Content Type ‘:l
Sort suggestions 7] Block [ v ]
@ According to frequency of usage V! Layer ==
Alphabetically J Hatch
! Text Style
AutoCorrect ) Dim Style
[¥] Enable AutcCorrect 7] Visual Style

[¥] Remember corrections after 3 mistypes

V] Search system variables
[¥] Separate commands and system variables

Suggestion list delay time 300  milliseconds

| OK | Cancel || Help ]

" A

Much of the new command line functionality, including AutoCorrect, mid-string search, and adaptive
suggestions, is also available using dynamic input.
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http://autocadinsider.autodesk.com/.a/6a00d8341c99d753ef017ee9a7bd4f970d-popup
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2. Burst vs. Explode

In this corner we have the tried and true explode command which does exactly as it states, it explodes and it explodes so
well that the attribute data that is filled in the block is replaced with the field description text which means you have to
re edit the data. So what does burst do that is different? Let’s use an example of an Interstate Road sign block with
attribute fields.

"‘ ' Edit Attributes E

Block name: M1-02

FIELD1

Figure 1 (The block as it comes into the drawing)

. V=
/_BUSINESS %, — oop

LOOP |

ELD

Figure 2 (A exploded block) Figure 3 (A ‘burst’ed block)

The block after using the burst command leaves the already defined attribute data intact. So the benefit of the burst
command is if you have data that you still want to include with your exploded block try using ‘Burst’.
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3. Launching Notepad

From inside Civil 3D you can launch notepad, all you have to do is type “Notepad” on the command line.

If you know the name of the file you can enter it after typing the command

If you don’t know the name just hit enter to launch notepad

" Untitled - Notepad
l File Edit Format View Help

»
—
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4. Content Explorer

If you haven’t used Content Explorer yet you are missing on some pretty neat functions. If you have used AutoCAD for a
while I'm sure you are familiar with Design Center and the functionality of inserting blocks, layers, etc.

Xelera-2@ 8gEEES- AUTODESK® SEEK design content

_’ | Folders |Open Drawings I Histcry|

| El
Folder List x -
[=- g Blocks -

=
+-F amows dwg EHighMast... EloadCerter EPoleDAm.. EPoleDAm... EPFolelumRem
-4 BoreHOLE dwg
= Drain¥S dwg
S B EEEN
- drplan.dwg
i[5 dplan_ex.dwg EPclelumRmv  GuyPole GuyWire HighMastPole  JunctBox =
- ftpsigns.dwg
- geotech dwg
i B 0@ HHA
3'" landscape. dg LoadCenter  LumPierCap LumUndrDeck  PoleDAm  PolsDAmRsl
o1 lighting.dwg
=-F lighting2 dwg 3
q'j Blocks —
~4H DetailViewStyles
}—lji Dimstyles Palelum FolelumlD  PolelumRel  PolslumSolid  PolePower
- iF Layers -
Layouts x

netypes

i Muttleaderstyles
i SectionViewStyles
@ Tablestyles

Al’ Textstyles

i) Visualstyles x
ih Hrefe

]--- Master Table Drawing.d'

No description found -

% mutcd.dwg
F-Fw obsoletesians.dwa

DesignCenter

]
C:A\FDOT2014.C3D\Data"Blocks"lighting2.dwg"Blocks (25 ttem(s))

Figure 4 "Design Center"

You can launch Content explorer either by typing it in or clicking it on the “Add-Ins” ribbon

‘,| O e B S KR - @ -|Bcvi3D -v o
-l Home Insert Annotate Modify Analyze View Output Manage Help ExpressTools Add-Ins  F

Explore

Content

Your first time using it you will need to add a watched folder(s), which will make content explorer index those locations.
The advantage of Indexing is it will allow you to do lightning quick searches for specific items however please allow some

time for indexing possibly setting it up to do that task overnight.
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WA Select Watched Folder S5

EJ Desktop
» ] Documents

1 Add Watched Folder...
Results (4)

LONIENT EXPICrel

v

o

£ Adobe Premiere Pro C56
F7 BentleyDownloads

£ C2012 54

B caicE

7 Civil 30 Project Templates
£ Civil 3D Projects

£ desc

Fle

£ FDOT2010

(= FDOT2012.C3D

» ] APPS

d m 3

4 ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥

Now that all of the indexing is done let’s look at some of what we can do. Let’s say you typed a note a while back and
can’t remember which file you put it in. | mean you really don’t want to have to retype a lengthy note; all you want to do
is copy and paste. So that being said you do remember parts of the note so let’s do a search..... You remember the date
of the revision so enter that in the search

& EA B ~ |revision 6-14-13
(o} ~ Blacks

.4
TS
E

Type Name Date Created Date Modified Location
Files (1)

lighting2.dwg
Text (1)

Revision
Notes dated...

| Revision Notes dated 6-14-13, Florida Dot is doing great things about keepi ..

POOF!!

The search has pulled up the exact drawing it is located in and the note in question, hopefully in future releases you will
be able to drag and drop it into your new drawing but for now you have to double click on the note and it will open the
drawing and zoom to the note so you can copy and paste it that way.
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k)»( @B B - [revision6-14-13 ® Q -
revision Notes dafed 61413, e —
Per redlines lighting revised to show Light Pole frEs flams DatcCreatcd jygg Date Modified | Location
stations and offset [FEs(Es ~

lighting2.dwg
Text (1) &

{1

Revision
Notes dated...

S5 Content Explorer

Results (2) ¥ E - A

Other searches that are at your finger tips are for certain layers that you want to add to a new drawing. Do a layer
search and providing you have the target drawing open you can double click on the desired layer and it will insert it into
your drawing along with the layer settings intact (Color, Line weight, etc..) You can also control the search filters.

| File Types | Object Types | Other Types | Date l

REDLLY 3DS

M asm @] BMP

|| CATPART || cATPRODUCT

DGN [|pLv3

[ ®) poc [C] 6] DOCX

DST DWF

DWEX DWG

g DWS pwT File Types | Object Types | Other Types | Date

[z DXF 49 Exp

[z FBX Le AutoCAD (15)

‘f‘:f;s 0 o Bh Attribute 5] Block Definition

[Pt | ]15D ,q?] Block Reference ﬁ Dim Style

[=] JPEG [=]JPG E3, Dimension * Ej Feature Contr... *

L | | MODEL £F Layer Layout

|| NEU L 1pce Line Type Bl MLeader *

L POF [ PNG =

1 8 por ] )T /7 MLeader Style  [¥] 5} Table Style

L PRT [ RaAR | [V] Eg, Text* [¥] Ay Text Style

[C] &) RTF ¥ [B saT [¥] [* Xref

|| SESSION || sLDasm

|| SLDPRT | |STE |

| sTEP [ |stP |

= TIF E T

[ wMF [ |x8

L]xT [CIE xs

[ # xLsx EI 3 zie

- — Items in bold are supported by the host application.

?ftr::snﬁﬁ:::;fu :L:fhp;n:i:};i;h; host application. *Items filtered out when browsing
ok ][ conce |

. - J
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5.Viewport, View, & Visual Style Controls

You can control some cool visualization right from your drawing screen without digging into the ribbon or options by

using the Viewport controls located in the top left corner of your drawing space.

Drawingl®

[-1Topll2D Wireframe]

Maxirnize Viewport
Viewport Configuration List 3

v | ViewCube
SteeringWheels

v | Mavigation Bar

1Topll2D Wireframe]

You can create viewports with just 2 clicks. Click on the [-] button

[+1[Top)[2D Wireframe]

I+1[Topli2D Wireframe]

[+][ToplI2D Wireframe]

Custem Viewport Configuration

Single

Two: Vertical
Twe: Horizontal
Three: Right
Three: Left
Three: Above
Three: Below
Three: Vertical
Three: Horizontal
Four: Equal
Four: Right
Four: Left

Cenfigure...

To return to just one viewport double click on the “+” button on the control bar...... Ok | cheated somewhat because if
you double click on the — symbol it automatically puts you in a 4 viewport state.... Just double click again to revert back

to a single.

You can also turn off the Viewcube and the Navigation bar if you are not using it just unclick them
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Restore Viewport
Wiewport Configuration List

v ViewCube
SteeringWheels

v Mavigation Bar

Want to change your view style? Easy that control is there also just click on the middle option which by default is in the
“TOP” view

Custom Model Views r

v | Top
Bottom
Left
Right
Front
Back
SW Isometric
SE Isometric
ME Isometric
MW Isometric

View Manager...

v Parallel

Perspective

Finally your Visual Style

Custom Visual Styles ]

v 2D Wireframe
Conceptual
Hidden
Realistic
Shaded
Shaded with edges
Shades of Gray
Sketchy
Wireframe
X-ray

Visual Styles Manager...

I’'m not sure if there are 50 shades of them though..
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6. Saving to a Previous Civil 3D Version

To send Civil 3D files to someone using a previous version, DO NOT use “save-as”; use export to AutoCAD and also send
an XML file containing the Civil 3D objects. Using the export option explodes the Aec objects within the drawing that
allows the other user to open the file up without seeing empty object boxes on the screen and by sending them a XML
file it will allow them to import the intelligent Civil 3D objects such as (Points, Surfaces, Drainage, etc...)

HDEE@@-F&v{é}cwnan ~|=

- . t Manag
Search Commanis .
'| £
5 E
S| Export to a different format " L
tnce g
Em
D Mew L4 - DWF
9 Create a DWF file and allow you to set |
page setup overrides.
E‘ Open ]
Fe DWFx
&{%j Create a DWFx file and allow you to set
E Save page setup overrides.
i 3D DWF
9 Save As ] (-;’ Create and display a DWF or DWFx file
of your 3D model in the DWF Viewer,
= Export C DWG [52012
= Convert and save civil models to base »
=5 AutoCAD drawings @2010
Q Publish »
DWG
@ Print ) Convert and save civil models to base AutoCAD drawings
. Press F1 for more help
D) Suite »
Workflows page setup overrides,

How the export to LandXML looks.

e —

Output | Manage ools  Add-Ins  FDOT [a]=

(A Export to LandXM

Specify objects to be exported:

[‘3’] Point Groups

@ Surfaces

; Alignments
+@ Sites

+5nﬁ Pipe Metworks
M [] Pressure Networks
Corridors

DSGHLTOL™ > A0y

Specify LandXML version:

Pick from drawing

I Ok ‘ I Cancel I I Help
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7.Select Similar Objects

You can select objects that are on the same layer in a crowded drawing very easily by using this command. Select one of
the objects and Right Click your mouse> pick select similar on the bottom of your shortcut menu and you should see on
your screen that all of the similar objects are awaiting for your edit of choice.... ALSO

Clipboard r
Basic Modify Tools 4 —
Display Order 4 ﬁ Select Similar SEﬂiI‘IgS @
Properties... Similar Based Cn :
E Ok
[ Quick Select... 7| olar
Drive ] Layer Cancel
Figure Properties... [ Linetype [ Hel ]
Edit Survey Figure Properties... Pl
Edit Figure Style... Linetype scale
Update from Survey Data Lineweight
Update Survey Data from Drawing
Browse to Survey Data Plat style
Elevation Editor... Obiect style
B} Object Viewer... Hare

Select Similar

Follow these steps:

1. To specify settings, type selectsimilar, press Enter, and select one or more objects. Press Enter to end selection.
At the Select objects or [SEttings]: prompt, use the Settings option to open the Select Similar Settings dialog
box.

2. Choose the properties you want for similarity.

3. Click OK to close the dialog box and select the objects.

4. Start an editing command. The objects remain selected so you can apply that command to the selected objects.

8. Copy with Base point

Copy with a base point the simple way; 'Ctrl+Alt+C' then select your base point, 'Ctrl+V' to paste. Very handy when
copying items from one detail sheet in paper space to another using a corner of the border as the base point. You can
also select an object and right click to get to it.

Repeat Copy with Base Point
Recent Input 3

Isolate Objects
Clipboard

¥ cut Ctrl+X
|T_"| Copy Ctrl+C

Basic Modify Tools 3
Display Order » rI'ZL- Copy with Base Point Ctrl+Shift+C
Pmperties... IE Paste Ctrl+V

[ Quick Select... Pacte as Block

T 4| Pasteto Original Coordinates
virl Drnfila
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9. Label Font Clarity

Try this trick on an older laptop with a LCD display that you still use. When you are creating or editing a label it doesn’t
appear as crisp and readable as you would like, you can change a display option in Windows that will help your display
read more clearly. First go to Start< Control Panel< Appearance and Personalization< Display< Adjust Clear Type text

==

~ YAppearance and Personalization
5, Change the theme

5 Change desktop background

Adjust screen resclution

iy —1 1 1 LI

ake text and other items larger or smaller | Adjust screen resolution Connect to an external display

— L LI o 1 q

Control Panel Home . . .
Make it easier to read what's on your screen

You can change the size of text and other items on your screen by choosing one of these options. To
temporarily enlarge just part of the screen, use the Magnifier tool.

..r—lx )
Change display settings _J

E Adjust ClearType text I S ClearTyp
Set custom text size (DPI)

Adjust reselution
'@' Calibrate color

Make the text on your screen easier to read

Turn on ClearType

ClearType is a software technology developed by Microsoft that improves the
readability of text on existing LCDs (Liguid Crystal Displays), such as laptop screens,
Pocket PC screens and flat panel monitors. With ClearType font technology, the words
onyour computer screen look almost as sharp and clear as those printed on a piece of
paper.

As you go through the wizard it will show you some examples of text and like an eye exam you choose what looks good.
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Click the text sample that looks best to you (1 of 4)

The Quick Brown Fox Jumps Over The Quick Brown Fox Jumps Over
the Lazy Dog. Lorem ipsum dolor the Lazy Dog. Lorem ipsum dolor
sit amet, consectetuer adipiscing sit amet, consectetuer adipiscing
elit. Mauris ornare odio vel risus. elit. Mauris ornare odio vel risus.
Maecenas elit metus, Maecenas elit metus,
pellentesque quis, pretium. pellentesgue quis, pretium.

[ Mext ][ Cancel

Once you make your choices finish out the wizard and that’s it.
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10. Change Grip Mode with Spacebar

When simply clicking on a grip when an object is highlighted you automatically go into the stretch command. Press the
space bar and you go into the move command. Press it again and you go into rotate, again for scale, and again for
mirror.

11. Changing the Visual effects of selection and rollover
highlighting

Want to change the visual effects of selection and rollover highlighting? Advanced settings can be found in "Options-
>Selection->Selection Preview group->Visual Effect Settings..."

Freview ™

V| When a command is active

Selection Preview Hfect Area Selection Efect
|| When no command is active

r Visual Effect Settings... ‘I

| Property preview

Face highlighting: | Indicate selection area
D Window selection color:
Line highlighting: | B Color 150 -
Dash Crossing selection color:
Thicken | O Color 100 "|
@ Both
Selection area opacity:
Advanced Options 25 D
[ ok | | Caneed | | Hep |
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12. Restricting Rollover Highlighting

Try setting the SELECTIONPREVIEW system variable to 2 if the rollover highlighting functionality degrades performance
in large drawings. This will restrict rollover highlighting to only be active when prompted for object selection from within
a command. This can also be set from "Options->Selection->Selection Preview group". This can help in the case of having
a drawing with a lot of Xref drawings namely a corridor drawing.

Preview
Selection preview
| When a command is active

When no command is active

| Visual Effect Settings...
Property preview

13. Split Tables into Columns

Did you know that Tables can now be broken into multiple parts but still be part of the same table. At the bottom of
every table object is a triangular grip. Click and drag this grip to set the breaking height for the table.

SUMMARY OF MAILBOXES

LOCAT ION
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14. QuickCalc

Did you know you can add architectural dimensions without converting them to decimal? Just type in the dimensions as
shown with the function desired.

o 4 @OI%TAX]
“ 31/4"+ 73747 |
Basic Calculator Mode @
NumberfPad e
e JL = JL v JL 2 J[ m |
Lz JLs JL oo JL = JL w2 |
Le JL. s JL 8 JL « J[ 3 ]
L Jb o2 Jlos JL - JL xy |
Lo J JLe JL ¢ JL o |
L= JL m J[ ™ J[ m J[ wmc |
[scentific -]
5| [UmitsConverson -]
14| ] |
x q
| & @O[ %% A X
= 3-1/4"+7-3/4" 0'-11"
9"+30" 3-3"
33"
Basic Calculator Mode @
NumberPd s

AutoCAD and Civil 3D Tips & Tricks Page 15




15. Deleting Duplicate Objects

You just received a file from a third party and it has duplicate objects drawn on top of each other on different layers (a
survey traverse as an example...)

Type in “Overkill” on the command line< select or window your objects in question< Enter

The DDO dialog box appears

Object Comparison Settings
Tolerance: 0,000001
Ignore object property:
|| Color Thickness
Transparency
Linetype Plot style
Linetype scale Material
Lineweight
Options

| Optimize segments within polylines
Ignare palyline segment widths

Do not break polylines

| Combine co-inear objects that partially overlap

| Combine codinear objects when aligned end to end

| Maintain assodative objects

Ok

For example let’s say that one of the items is on a layer that you want to keep. When the DDO dialog box appears select
the layer option and as long as that layer is current it will delete all of the other objects except for the current layer’s
object.
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16. Swapping Multiple Parts at One Time

You have just finished a lengthy drainage design and the reviewer wants you to change out some structures to a certain
type and have you change a pipe size on 10 pipes to a size bigger well that is easy now with our own FDOT tool called
swap parts. Out of the box Civil 3D only allows you to swap one part at a time. So in this case we will launch the Swap
Parts located on the FDOT Ribbon.

.J. 1, 2 Point Twist LandXML Converter .,-::‘.l"
& Untwist View LandXML Grouper
k ; Existing

Create
File ZH Length Calc I ﬁ Swap Parts I LaneSlope

Tools

e -

After Selecting all of the structures and pipes you need to change press enter and the swap parts dialog parts box pops
up. It populates with the current parts list that you are using, which in this case is the FDOT Drainage parts list. Make all
of your edits and select ok. Presto... all of your structures and pipes change.

Fart List

[FDCIT Drainage

Fipe Part Family

[on Culver Concrete Pipe

Fipe

| 3'x 3 Box Culvert

Structure Part Family

[Index Mo. 217 - Median Bamier Inlet 3 with Rectangular
Shucture

| Precast Median Barier Inlet Type 3 {1 : 5 Grate Slope ) ~ |

[ Ok J[ Cancel ]
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17. AutoCAD 2014 Layer Enhancements

In AutoCAD 2014 the number of layers displayed on the ribbon has been increased. And, layers are now displayed using
natural ordered sort. For example, the layer names 1, 4, 25, 6, 21, 2, 10 are sorted as 1, 2, 4, 6, 10, 21, 25 instead of 1,
10, 2, 25, 21, 4, 6.

I:: Current layer: 0 Search for laye Q
ESR| s vRXe (1
>l S. Name O. Fr.. L. Col. Linety.. Linew.. Tran.. Plot.. P. N. V. VP
0 ¢ % &f i w. Contin. — De.. 0 Colo.. © & T | ¢
< layerl |9 % of | w.. Contin.. — De.. 0 Colo.. © B B |l
g <7 Layer2 9 % of B w.. Contin.. — De.. 0 Colo.. & B & ]
% < layerd |9 % gf [l w.. Contin.. — De.. 0 Colo.. & B B |
= < layer6 |9 % of | w.. Contin.. — De.. 0 Colo.. © & & |
2 < layerlo |9 % &f I w.. Contin.. — De.. 0 Colo.. © & B ]
&l || Layer21 |9 ¥ &f [l w.. Contin.. — De.. 0 Colo.. © B B ] ¢
£l ||© Layer2s |9 3 & B w.. Contin.. — De.. 0 Colo.. © & & | v
h; »|| €| 1 | »
S =
& @ ~ All: 8 layers displayed of 8 total layers

A new Merge option in the Layer Manager enables you to select one or more layers from the layer list and merge the
objects from those layers onto a different layer. The original layers are automatically purged from the drawing.

x
o Current layer: 0 Search for layer Q
BeR| 8 o5Xy a2 L
=) r
1| 5. Name vi 0. Fre.. L. Color Linetype Linewei. Trans.. PlotS.. P. * A Merge to Layer u
& TS-TEXT2 |9 % & B w. CONTIN. — Defa.. 0 Color] &
- (18 TEXT4 TR e
Show Filter Tree r
= TBTEXT3 ‘o
~ 1B TEXT1 Show Filters in Layer List DEFPOINTS
5 Bevation_Dim
& T8 INFORMATION Ao 0 E= Béerior Hevations ()
< TB_CORNERS 0 3 & PS_Annot
= T8_BORDER Nowr\ oy 0 £ & TePORDER
27 PS_Viewport Rename Layer F2 0 | @ T8 CORNERS
&7 PS_Annot Delete Layer 0 lo S TB_INFORMATION w
; &7 Exterior Elevations|WAL : 0 ! & TS-TEXT2
Change Description e
&7 Bxterior Elevations|LAYE R ¢ Croos Fit 0 olor_... &
o7 __Fvranne FlayatinnclFlan YSHIOVE FEOR SHODP S et n lae [
§~ d| | Remove Viewport Overrides for » ’
2 @~ All: 24 layers displayed of New Layer VP Frozen in All Viewports
VP Freeze Layer »
VP Thaw Layer in All Viewports
Isolate selected layers oK) [ Cancel '] [ Hep |
(" Merge selected layes(s) to ... ) |
i , - — \ J
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18. Reverse a Polyline in AutoCAD

Probably my favorite entity in AutoCAD is the polyline. However, there have been a few things in the past that I've found
somewhat annoying, one of which is controlling the direction of polylines.

Normally the direction of polylines makes little difference, but for some purposes it can be important. For example,
linetype text is oriented in line with the direction of the line segment, so if the polyline flows from right to left, as opposed to
from left to right, the text will appear upside-down.

Liyout  Parsratc  View  Manage  Output  Plug-ns  Online  Express T4

A ‘o REVERSE

Press F1 for more help

Reversing the vertices in a polyline has historically been quite
cumbersome to achieve, but as of AutoCAD 2010, there is now a REVERSE command. Simply enter the REVERSE
command by either typing it, or selecting it from the Home ribbon, and select the polyline you want to reverse.

This command can also be used on a few other entities, namely LINE, SPLINE and HELIX entities.

“Before” “After”
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19. Clean your Screen with AutoCAD’s Clean Screen Feature

A caller asked:

| have lost my menus such as draw, render, etc. Everything that would allow me to copy, move, trim etc. | don’t have
anything that will allow me to enter commands. Also my menu bar ie. file, window, help. The command line at the bottom
of the drawing is also gone.

Since | didn’t see the viewer’s screen, | can’t be sure what happened. Maybe his menu was unloaded. (In that case, try
the MENULOAD command.) But it could also describe the Clean Screen feature—although Clean Screen keeps the
command line.

The Clean Screen feature in AutoCAD hides as much as possible of your screen, giving you maximum room for drawing.
It doesn’t turn everything off on your screen, but almost everything. Here’s what'’s left:

e Status bar
e Menu bar (if you have it displayed)
e Command line

Here’s what my screen looks like with Clean Screen on.

'F YN N S I 5 Drafting & Annataton ~}

|- NTopli2D Wireframe] @R

45 1w\ wodel [ Lapou / Layout2 /.
p Sl

Clean Screen is great for keyboard jockeys who like to type in commands and aliases.

To turn on Clean Screen, click the Clean Screen button at the right end of the status bar (it looks like a box) or press Ctrl +
0. Repeat the process to turn Clean Screen off. The actual command names are CLEANSCREENON and
CLEANSCREENOFF.

AutoCAD and Civil 3D Tips & Tricks Page 20




20. Close AutoCAD quickly and safely

When you may want to rush out the door, here is a tip that your family will thank you for knowing!

AutoCAD Message [mtdm|

Go Home!

\We've all done it. You are beavering away at the office, totally engrossed in-the-Music-on-your
Ped in your work, when you realize that it was time to go home minutes ago!

I want to make sure that you know about 3 really handy commands that will help you to close down a lot of open files very
quickly (and safely).

Save everything

The first command is an Express tool called SAVEALL. Simply type saveall at the command line, and all your open
drawings will be saved, but remain open.

Close everything

The second command is a standard AutoCAD command called CLOSEALL. Once again, simply type closeallat the
command line, and all your drawings will be closed Lickety Split.

Or do both

The final command is another Express tool called QQUIT. This tool will attempt to save and close all your drawings, and
then close AutoCAD down completely.

Note: If a drawing has not been saved yet, all of these commands will prompt for a file name. If you have a blank drawing
file open that you don’t need to save — just hit ‘Cancel’, AutoCAD will still process the rest of the files.

Go Home
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21. NEW Civil 3D 2014 Survey feature

Two quick things to show. The first one is the ability to use Automatic Pan and Zoom to Survey Figure. This is useful in
case you were reviewing or editing your figure. Now as soon as you select Survey Figure Properties the program zooms
to the figure. This setting is found in Survey User Settings dialog.

h Survey User Settings

T

fr 2+

Property

Yalue

=1 |

Process linework sequence

-1 5% Figure Defaults

= Interactive Graphi

- Show backsight prism
Show station instrument

=1 L3 L

By import order

C\ProgramData\ Autodesk\ C3... Ea

B‘

Figure prefix database path

Current figure prefix database 5531 3ample
Figure style [’ Standard
Figure layer £10

¥ Automatic pan and zoom Yes

Il 255.0,255
[] 255,255.0

el WIRETLTN]

-

m

P

Another quick thing to introduce is the ability to Import or Export Survey Query Files from a Survey database. This way
you can export all defined queries from your Survey database to a specified location. The program will create a query file
with a QML file format. This query can also be imported into the Survey database.

In your Survey Toolspace tab, if you right-click on Survey Queries and choose Export you will see the option.

5 testl
EIQ Import Events

i 5 Survey-1.fbk

?‘? Survey Queries

EIIH Metworks
w5 t

[IE] Metwork Groups

EIEI Figures

w- Tty £

Mew..

Open from file...

Import...

o[} TC1
+ 3 1A
= [H TC2

Add to surface...

Refresh

s T
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22. FDOT Help & Links

Located on the FDOT Ribbon is the Links & Contacts command. Clicking on it will launch the FDOT Help section where
not only can you contact us direct with questions there are links to various FDOT websites

Engineering CADD Systems Office Support Sta

* Engineering Links |
ECSO Home Page

ECSO Publications I
CADD Production Criteria Handbook (CPCH) .
Office of Design Publications
FDOT Design Standards
Plans Preparation Manual
State Of Florida County Maps

FDOT Civil 3d Work Flows

ECSO GoToMeeting
Explore FDOT2014.¢3d Directory

Engineering CADD /7™

* L] * . I'-_ '; B t '
Florida’s Transportation Engineers i

23. Fillet a Closed Polyline

In 2014 you can now fillet a closed polyline. Once you enter the FILLET command you have options displayed on the
command line. Select P for polyline to fillet the entire polyline. A preview of how it will look displays when you hover
over the Pline

(D
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24. New Coordinate Zone display in 2014
In Civil 3D 2014 along the bottom right corner of your screen next to the current annotation scale there is a display of
what coordinate zone your drawing is currently in. The Red push pin to the left is the Geographic Marker which most of

the time you will want to turn off.

Geographic Marker Visibility: On
Latitude: 24.3205

Longtitude: -82.9703

Elevation: 0.0000

@ | FL83EF | 1=

25. Thumbnail settings

Do you have old drawings that don’t show thumbnails when you select them in the Select File dialog box?

A Select File i
Look i | | Diawings - =B O KB Vews v Toks v
Mame : Date modified T = Previaw
= ES Cantech 5002208 DWG 13/6/2010 4ZLPM 8
BN Cantech SU0Z2AFP.OWG 1262010 21PN £
T, FS Cantech 5002288 DWW 10/6/2010 431FM 2
b ¥ Cantech 500228PD.0WG 12/6/2010 21PN 2 |
B3 Cantech S002284F.0W5 13/6/2010 AZLPM 4 I
FS Cantech 50022849 DWG \ 12/6/2010 4Z1PM 8 o
& FS Cantech S0022BBF.DWG s aziem g | el View
FS Cantech SH02288P.00W/6 12/6/2010 421N 2
: F3 Cantech SI0228F.0WG 12672010 41PN & ELE M I
g B Cantech S00220P.0WG 13/6/2010 AZ1PM 8
BN Cantech S00711F.DWE 10/6/3010 421PM 8
FS Cantech S00222F.DWG 12/8/2010 421PM 2
ke PR Cantech WILLARD.DW 12/6/2010 421PM 2
B circles.dwg Y5 EATPM 8
BN Clow b-20824.dwg 10/6/2010 4Z1PM 2
3 BN Clow b-20908.dwg 10/6/2010 431FM &
£ m L3
i name  Cartech SO0Z2BAF DWG » [ Dpen |[=
| Filesof yps:  [Diawingcg] =|[  Cancal

Even though this drawing says it was last modified in 2010, it was created much earlier. It's probably at least 15 years old.
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1 H B G & = G0 | {Siontting &Annotation _ ~|®

= ¢ B &
‘(’:.__lD () Recent Documents + [ [lunsaved s
By Orderedlist v 5]~ e Qbhd
e
IS Cantech 500228AF.DWG ‘ —
= L_Cantach S0022BAf
=57 Open ’
B csted nocan Bible\Drawings\Cantech S0022BAF.DWG
S canted
(=
S canted
9} swess v [Mpiate
= 3abon
Ty
[3 Export b B savor
= 3abont
E Publish »
S
= Drawing
&7 | Utilites
Optf
Date modified: 12/6/2010 4:21:35 PM
Version inf
Last saved by

The system variable that determines whether a drawing saves a thumbnail is THUMBSAVE. It replaces the earlier
RASTERSAVE. The default value, 1, saves a thumbnail, but older drawings might not have one.

You'll see the same problem in the list of recent drawings when you click the AutoCAD button as you see here on the
right.

How to save a thumbnail

Here are the steps to get a thumbnail both in the Select File dialog box and in the list of recent drawings:

1. Type thumbsave on the command line. If the value is 0, change it to 1. In
my drawing, the value was 1, but it’s possible that | simply hadn’t opened
and saved the drawing in many years.

You can also change the setting by typing options on the Command line. In the Options dialog box, click the Open &
Save tab, and then click the Thumbnail Preview Settings button. Make sure that the top check box is checked. You can
specify the current display or a default “home” display. You can also specify settings for sheets and view and control the
pixel size. Setting a higher pixel size will make the image look clearer. Click OK twice to return to your drawing.
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Dharearg
Save a thumbnal previess image:
) Use viaw when draving last saved

@ Uze Home Yiew

Eheets snd Views
W [J] Generale Shesl, Sheet View ard Model View Thunbeails

Peslcemance Accuracy

0

Update thumbnails wien accessed

Harmed visws

W awrmum see n paels

1. Save the drawing and close it.

2. Now, click the AutoCAD button, then click Open and select the drawing.
Now, you'll see a preview thumbnail in the Preview box. Note that you
need to be showing previews in the Select File dialog box. At the upper-
right corner of the dialog box, choose Views, then Thumbnails.

a breakline. dug

E CAD 2010 Updated Ribbon Menu.dwg

ES Conbech 1-97C.0W6

FS Cantech SDOZ28F DG
FR Cantech S00Z2AFP.DWG
FS Cantech S00Z2AP.0WVG
S Cantech SD0Z2APD.DWS
FS Canbech SO022BAF.DWG

4 | i

Flename  Cartech SOIZIBAF DWG

Files of ype: | Dirawing g

1/5/2003 6:34 P

B/8/2010 2:46 P

62743012 2:23 PM
124652010 4:31 P
12/652010 421 PM
12/6/2010 4:21 PM
12/6/2010 4:21 PM
4/14/3013 2:01 PM

A Select File =
Lookin: | | Drswings - 4B A ME Vew v Todks -
g Name ) Diate miodified = Previaw
E.ﬂ.rw COE Gas Bdraction Well.dwg 126,200 4:21 PM ——rr
ES Arrry COE Rlelease Yalve.dwg 12/6/2010 421 PM ! —1
T :q.ﬂ.rm_hlr Corp of Eng Air Compressor.dwg 124642010 4:31 P | il J
— - - I
b S Bathlohem black.dwg 124672010 £21PM |2 :
'E Bethlehern poroupine dig 12/6/2010 4:21 P i
S bigroom.dwg /1172007 1:43 PM _—
& E% Bldg(Revs) Safety Equipment Sep 09 fram R, 3/10/2013 12:05 PM Il Ve
S boltl dwg £/1/2009 3:04 P _
] Select Irhal View
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That's much more helpful!

But to get the preview in the Recent Drawings list, you need to close AutoCAD and re-open it. Click the AutoCAD button
and you'll see the thumbnail preview.

Search Commands Q

- || |5l Z

= @0 | Unsaved L:

) Recent Documents

|By Ordered List v| ||:|'__| v|

[
| Cantech S0022BAF.DWG f=l |

E Opan ' Cante

CAAutoCAD BibleADrawings\Cantech S0022BAF.DWG
Cante
[
E Sawe
P Cante ————————
- =|=_‘
E Save As 3 plate J
3dbalt 4'. i
=p Export D 3dbolt S ’if“‘i
3dbolt )
%‘7 Publish r P
@ Print » Date modified: 41472013 20425 P
Wersion infor AutoCAD 2013
B Drrawing »
ﬁ Utilities Last saved by
Currently open by
a Clase 4

| Options | | Exit Autodesk AutaCAD 2014
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26. Launching AutoCAD in Safe mode

Starting AutoCAD in Windows diagnostic mode

Issue

You are experiencing problems with AutoCAD, and you want to know how to start Windows® in a clean
environment in order to troubleshoot the problem.

Solution

A common way to troubleshoot AutoCAD problems is to run the software in safe mode. However, this method of
troubleshooting does not work with newer versions of software because the necessary Autodesk licensing services
do not load in safe mode.

In this situation, the best troubleshooting alternative is to use MSCONFIG to restart the Windows system in a state
similar to safe mode, but with the licensing services running. Follow these steps:

Windows 7:

1. From the Start menu, click into the Search programs and files edit box

2. Enter msconfig

3. Select msconfig from the programs list

6. Click OK

7. When prompted, restart Windows.

Note: If you are running a network-licensed version of the product, you will first need to borrow the network license.

Autodesk Licensing Service (2005 through 2009 releases)
FLEXnet Licensing Service (2010 through 2014 releases)

To return to a normal Windows startup:
Windows 7:
1. From the Start menu, click into the Search programs and files edit box
2. Enter msconfig

3. Select msconfig from the programs list
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